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Overview 

 

New in Version 7.23  

• Support for Bilingual dictionaries 

• Highlight Bookmarks – advanced bookmark feature that goes beyond 
painting with user defined colors to provide study functionality such as 
attaching user notes to highlighted passages, jumping to the next/previous 
bookmarked passage with history arrows. 

• Copy feature now works not only with the current verses but with user 
defined highlighted passages 

• Possibility to choose Command toolbar position (top/bottom) 

• Improved Select Commentary feature - works with an expandable list of 
icons for selecting commentaries for a more compact view. 

 

Bible With You is a powerful Palm OS Bible reader allowing not only reading and 
studying the complete texts of different Bible translations, but also using 
commentary resources, cross-references, dictionaries, images and original language 
resources. Even challenges like the complete version of Mathew Henry’s 
commentaries are not a hindrance for the excellent performance of the reader. The 
application supports hires+ and could be installed in the RAM as well as on a Memory 
Card. 

Bible With You is equally convenient for reading as well as for studying the Bible. 
The user interface is easy-to-use and intuitive. 

The biblical texts are presented in rich text, combining bold, italic, colors and multiple 
font sizes. You could adjust the reading preferences according to your needs. The 
Apply bold formatting feature enforces bold format for the whole text (helpful for 
users with poor eyesight) and font size remapping increases/decreases the font size 
even for devices with 160/160 screen. The reading of the Bible is especially 
facilitated by the Reading mode, allowing you to define a set of reading preferences 
(font size appropriate for reading longer passages, hiding Strong’s numbers and 
other information that, while useful when you do a research, might distract your 
attention from the text itself). Thus, next time you decide to read the Bible (whether 
following a plan or not) you will already have your reading preferences saved and 
will fully concentrate on the reading. Using the Ribbon feature you can easily follow 
a Bible reading plan. The ribbons are automatically updated bookmarks showing the 
place you stop your reading.  The Auto Scroll and the Screen Wrap features help 
you fully concentrate on the text. 



 

While when you read the Bible you would like to concentrate on the text, when you 
study the Bible by yourself or when you take your Bible With You on church or at 
the prayer meeting, you would probably prefer to have information like footnotes 
and Strong’s numbers visible and ready to be used. You might also prefer a different 
font size than the one you use for reading. That is why Bible With You allows 
setting different study-oriented preferences for a Study mode and you can switch 
between Study and Reading without changing preferences all the time. The 
navigation in Study mode also differs from this in the Reading mode. You can 
choose between the Select Bible Verse feature (consequently choose book, 
chapter and verse) and the Graffiti navigation. The uniqueness of this feature is 
the opportunity for navigating not only within the active book by drawing chapter 
and verse numbers in the Number area, but also to choose a Bible book through 
drawing the corresponding letter abbreviation. 

Helpful features for your Bible study are also the possibility for taking Notes (new 
for 5.0), the significantly improved Bookmarks (now allowing categories), 
cross-references appearing as pop-ups, cross-references and Strong’s definitions 
working as hyper links, as well as with the Compare study mode. 

In Bible With You 6.0 you will find still other study oriented functionality like the 
possibility for using the available Bible References databases with different 
translations. For example, you can look at the NASB references while reading KJV. 
What is more, now you can personalize your study experience by choosing your own 
set of study resources – Bible, Commentary book, Dictionary, Cross References. The 
complete version of Mathew Henry’s Commentaries for Bible With You integrates 
with the Bible translations by allowing you when switching from the Bible to the 
Commentaries to choose whether to go to the corresponding commentary about 
the active verse, chapter or book.  

The search in the Bible is implemented through a separate program Bible 
Concordance With You, closely integrated with Bible With You. The practically 
instant results allow performing on-tap searches, where the results appear while you 
enter the words. Bible Concordance With You also allows searching for phrases, 
using advanced options like OR, AND and even NOT. In addition, you can use 
wildcards in your search query. A flexible way for setting the search range gives 
you the opportunity to easily define the book in which a search will be performed.  

For a thematic Bible study you can be facilitated by Bible Explorer With You. It 
comes with several databases like Torrey's New Topical Textbook, Treasury of 
Scripture Knowledge, Geographical Names in the Bible, GNT Word Index and other. 

Bible With You, Bible Concordance With You and Bible Explorer With You 
are separate applications, but are closely integrated with each other through the 
Show Verse Protocol, supported by them, as well as by several other 3rd party 
products. 

 



 

 

 

How to purchase Bible With You 
Purchase from:   http://www.gmpsoft.com  
 

� Go to Products page 
� Find the product you desire 
� Click on BUY and follow the instructions 

 
For more information about GMPSoft’s products and services, visit us at: 
http://www.gmpsoft.com. 
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1 Start the application 
 
Locate the Bible With You icon on the Applications screen of your Palm OS 
handheld.  Launch the application by tapping on the icon.  
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 



 

2 Registration 

2.1 Licenses 
GMPSoft offers the following licenses for using its products: 
 

1. Trial License – Includes all the functionality of the Standard License 
plus indication that the product needs to be registered. 
2. Standard License – Indicates that you have successfully licensed a 
GMPSoft’s product.  
3. Limited License –Indicates that you have availed of the opportunity for 
one limited license for a GMPSoft’s product. The Limited License is free. 
4. Free License – Indicates that you have licensed a free GMPSoft’s product. 

 
 

2.2 Product Registration  
This fully functioning product can be registered with the help of PADUnlock file (PAlm 
Database Unlock System). PADUnlock is a standard database file (.pdb) containing 
your registration information for each of the products you have purchased. You 
receive your PADUnlock file after you order a License for a GMPSoft product and 
register it in our system database.  
 
1. Get your PADUnlock: 

� Follow the Unlock Key link in the GMPSoft Sales 
Confirmation email you have received after the 
purchase. 

� Click on GET IT link in your Product Info page.  
� Save the file on your PC 

 
2. Install PADUnlock 

� Hotsync the PADUnlock database to your device’s 
RAM or on the expansion card. 

 
 

3. Go to the Registration form: 
� Launch a GMPSoft product 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on Book 
� Tap on Registration 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

R on the silkscreen 
Or 

� Tap on the Register button in the trial reminder 
form  

 



 

 
4. Apply your PADUnlock registration information: 

� Tap on the Scan button  
 
GMPSoft products support PADUnlock Key protocol and use 
it to automatically register your products. 

 
Note: The Trial reminder form will still appear if there is even 
one product with a Trial License state. 

 
 
 

 



 

  
 

3 Study Mode 
You can use Bible With You to read the Bible (see 5. 
Reading Mode), to study the Bible or a complementary book (see 3. Study Mode) or 
to compare two Bible versions (4. Comparison Study Mode).   
 

3.1 Select a Bible translation 

Bible With You allows having several Bible translations installed and switching 
between them. When you change the current translation, the active verse will be 
automatically displayed in the corresponding Bible translation. 

1. Open the Select Books form 
� Tap on the abbreviation of the Bible translation in the 

Command Toolbar  
Or  
� Tap on the Headline bar or the Menu button to display 

the Book menu 
� Tap on Bible... 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

B on the silkscreen 
 
 
 
2. Scan for new Bible translations  

� Tap on Scan 
 
Bible With You stores cached information about the 
available databases. This speeds the operation when you use 
memory cards.  
 
It is not necessary to scan each time. Scan when you: 

• Install new Bible(s) 
• Delete Bible(s) 
• Transfer Bible(s) from handheld RAM to the memory 

card or vice versa 
• Move Bible(s) in another folder of the memory card 

 
 
 
 
 
 
 
 
 
 

 

 



 

3. Choose a Bible translation 
� Tap on the desired Bible translation in the list 

 
Gray status of a checkbox indicates one of the following: 
 
• There are no Bible translations or study resources 

installed (if you have installed a Bible translation or a 
new resource after the last scan, scan again) 

• The Bible translations are not synchronized. You need to 
download and install the latest version of all GMPSoft 
products you are using. Get them from our website: 
www.gmpsoft.com 

  
4. Confirm 

� Tap on the Done button 
 
 

3.2 Adjusting the preferences 
Bible With You allows adjusting different sets of preferences for reading (see 5.1. 
Adjusting the Reading Mode Preferences) and for studying the Bible. For example, 
you could have Strong’s numbers disabled in Reading mode, and enabled in Study 
mode. 
 

3.2.1 Adjusting the Text Presentation Preferences 

Allows choosing the font size, the paragraph or verse 
formatting, colored or BW display, and view the last line 
from the previous screen when paging Up/Down. 

 
1. Choose Text Preferences from the Edit menu 

� Tap on the Headline bar or use the Menu button to 
display the form menu 

� Tap on the Edit menu 
� Tap on Text Preferences 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

P on the silkscreen 

  
2. Text size – you can choose Smaller size to have 
more text displayed at a time (if you do a research) 
or Larger (if you memorize verses or use Bible With You in church) 
� Tap on the down arrow next to the Text size field  
� Choose a text size from the drop down list 
 

3. Arrange the text by Paragraphs/Verses -  for Bible study is recommended 
arrangement by verses  
� Tap on the down arrow next to Arrange text by  
� Choose desired formatting from the drop down list 

 



 

 

3.2.2 Adjusting the Preferences for Viewing Additional Information 

Allows you to choose between showing or hiding the 
Strong’s numbers, the footnotes, the references in the 
Opens Bible With You on the last passage read in the 
Book, where you have the Ribbon attached. 

 
1. Choose View Preferences from the Edit menu 

� Tap on the Headline bar or use the Menu button to 
display the form menu 

� Tap on the Edit menu 
� Tap on View Preferences 

 
2. Show Strong’s Numbers – enable this option to 
check what original Hebrew/Greek word is used. 
For more information about Strong’s Numbers see 
3.14) 
 
Note: Strong’s numbers feature is available only for Bible 
translations that provide this information.   
 
� Enable Show Strong’s check box 
� Tap on the down arrow next to Show Strong’s check 

box 
� Select Numbers or Marks from the drop-down list 
  

3. Show/hide footnotes – it is recommended this option to be enabled in Study 
mode. For more information about footnotes see 3.12) 
Note: Works only for Bible versions providing footnotes 
� Tap on Show footnotes check box to change 

alternatively its state 
Or 
� Draw the Graffiti Menu Command stroke to display the 

Menu bar 
� Tap on the F  icon  
 
Or 
� Tap on F icon in the Command Toolbar if it is shown 

 

4. Show/hide references - it is recommended this option to be enabled in Study 
mode. For more information about cross-references see 3.13) 

 
Note: Works only for Bible versions providing cross-
references 
 
� Tap on Show references check box to change 

alternatively its state 
Or 
� Draw the Graffiti Menu Command stroke to display the 

Menu bar 
� Tap on the R  icon  
 

 

 

 



 

 

 
 

Or 
� Tap on R  icon in the Command Toolbar when it is shown 
 

5. View last line 
This feature allows you to vie the last line of the previous 
page when paging down the text. 
 

 

6. Mark User Notes 
With this option enabled, Bible With You will place a blue 
asterisk (*) at the beginning of the verses for which you have 
added your personal notes 
� Enable the Mark User Notes check box 
 

7. Confirm 
� Tap on the OK button 

 

3.3 Adjusting the preferences for the Command Toolbar 
The Command Toolbar contains icons for easier selection of 
some of the commands in Bible With You reader – Select 
Bible translation; Previous/Next passage; Add to Bookmarks, 
View Bookmarks, Copy and others.  
You may choose between 3 modes of the Command Toolbar 
– always hidden, always shown, or, in devices with virtual 
graffiti silkscreen area – the Command Toolbar may be 
automatically hidden when the graffiti area is displayed. You 
can also choose to position the Command Toolbar – at the 
top or at the bottom of the screen.  

 
1. Choose Toolbars from the Edit menu 

� Tap on the Headline bar or use the Menu button to 
display the form menu 

� Tap on the Edit menu 
� Tap on Toolbars… 
Or 
� Draw the Graffiti Menu Command stroke   and the 

number 1 on the silkscreen 
 
 
2. Select a status of the Command Toolbar 

� Tap on the down arrow next to the Command toolbar  
field  

� Choose status for the toolbar from the drop down list 
 
Possible statuses of the Command Toolbar are: 
 
Hide – the Command Toolbar is hidden 
 
Show – the Command Toolbar is shown both in 320x320  
(160x160) as well as in expanded 320x480 screens 

 

 



 

 
 

 

 
Auto show - the Command Toolbar is hidden for 320x320  
(160x160) screen displays and is shown for the expanded 
320x480 screen. 
 

3. Select position for the Command Toolbar 
� Tap on the down arrow next to Show Command 

toolbar field  
� Choose position for the toolbar from the drop down list 
 
The possible positions of the Command Toolbar are: 
 
Top – the Command Toolbar will be displayed at the top of 
the text below the Headline bar.  
 
Down – the Command Toolbar will be displayed at the 
bottom of the text 
 
 
 

4. Confirm your preferences 
� Tap on OK  
 
 
 
 
 
 
 
 

3.4 Reading the Bible 
 
1. Read a chapter - when you read the Bible in Study 
mode, the text is presented chapter by chapter.  

 
� Use the scroll bar to move the text up and down 

within a chapter 
Or 

� Move the Sony Jog Dial wheel up/down to move the 
text per one line. 

 

2. Activate a verse – when you study a particular 
verse, you can make this verse active and read the 
chapter context 

� Tap on the desired verse in the text 
The active verse will move to the top of the text area. 
 
Active verse is the one displayed in the header section. 
Scrolling the text does not change the active verse. 
 

 



 

3. Jump to the active verse – having read the context of the active verse you can 
easily return to this verse to continue your study 

� Push and release the Sony Jog Dial wheel 

 
4. Move the text up and down by pages and continue to next/previous chapter 

� Use Page Up/Page Down buttons of your handheld  
Or  

� Push the Sony Jog Dial wheel and move it 
up/down. 

 
 
 
 
 
 
 

3.5 Navigation in the Bible 
Navigation is an important part of the study process. That is why Bible With You 
offers different ways for navigation in Study mode that could be used in different 
situations and according to your personal preferences. 

3.5.1 Form navigation 

You can change the active Bible version, book, chapter or verse by tapping on the 
corresponding field in the Select Book/Select Chapter/Select Verse forms. Your 
choice of active book is facilitated by having the books colored by groups. 
 
Selection order is from a more general to more specific object (once you have 
selected a book, the Select Chapter form opens. After choosing a chapter, the 
Select Verse form opens).  
 
1. Open the Select Book/Select Chapter/Select 

Verse form 
� Tap on the book abbreviation or chapter/verse number 

field in the Command Toolbar. 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

L 
 
 
 
2. Select a book 

� Tap on a book abbreviation in the Select Book form 

 
Red font indicates current book 
 
 
 

 

 



 

 
 
 
 

3. Select a chapter 
� Tap on the desired number in the list 
 
Red font indicates current chapter number  
 
 
 
 
 
 
 
 
 
 

4. Select a verse 
� Tap on the respective number in the list 
 
Red font indicates verse number 

 
Important: If the number of chapters or verses is more 
than one hundred they will be displayed in two forms 
 
5. View more chapter or verse numbers 

� Tap on ‘+’ button  

6. View smaller chapter or verse numbers 
� Tap on ‘-’ button  
 

3.5.2 Graffiti Navigation System 

The Graffiti Navigation System allows you to move in the text quickly and 
conveniently by writing Letters and Numbers in the Graffiti silkscreen area or 
alternatively by entering them with the Virtual Keyboard.  
 
1. Select a Bible book 
 

� Write a letter on the Alpha Graffiti area or use 
alternatively the Virtual or the Hardware Keyboard. 

 
This will activate the Graffiti Navigation System. The first of 
all books starting with the letter you have entered will 
become the active book. 
 
If there are several books starting with the same letter, their 
abbreviations will be listed at the bottom of the text area. 
 

 

 

  

 



 

� Now you can choose to enter the next letters of 
the book abbreviation or to tap on the field with 
book abbreviations. 

 
The book is finally defined when you have tapped on its 
abbreviation or you have entered a consequence of letters 
that uniquely define it.   
 
For example, to go to Jeremiah, you need to enter J. All the 
books starting with J will be listed. The second letter - e –will 
define uniquely the book as there are no other books’ 
abbreviations starting with Je. 
 
In case the desired book is the first one in the list, just tap 
once on the silk screen to confirm and deactivate the Graffiti 
Navigation System. 

  
 

Notes:  
1. The Graffiti Navigation System is automatically 
deactivated 5 seconds after you stop entering letters or 
digits.  
 
2. When you need one book from a set (for example, one of 
1Jo, 2Jo, 3Jo), the number of the book is ignored – all three 
books are interpreted as Jo.  
Warning: The only way to point one book from the set is to 
tap on the field with the corresponding book abbreviation. 

 
2. Select a chapter/verse  
 
2.1 Enter a chapter number 

� Enter a digit using the Numeric Graffiti area, the 
Virtual Keyboard, or the Hardware Keyboard. 

 
This will activate the Graffiti Navigation System.  
 
The Chapter/Verse field at the Menu bar will show the digit 
that was entered. If it is followed by a dash, this is an 
indication that more digits can be entered to point a chapter 
number.  
 

� Enter the next digits of the chapter if this is 
necessary. 

 
For example, if you want to go to Genesis 50, you need to 
write 5 and then 0.   
 
Note: When you have entered the desired chapter number, 
but more digits may be entered (for example, chapter 5 out 
of 50), you can single tap on the Numeric area to confirm. 
 

 

 

 

 



 

 
2.1 Select a verse 

Select a verse mode is automatically activated after you 
have selected a chapter number.  
 

� Continue by entering the digits of the verse number 
the same way you do for a chapter. 

 
Note: If you need to jump to a verse in the same chapter, 
tap once on the Numeric area to skip entering the chapter 
number or tap on the dot (.) on the Virtual Keyboard, or 
the Hardware Keyboard 
 
Notes:  
 
1. Bible With You automatically monitors the digits that 
have been entered and if the digits entered for a 
Chapter/Verse number are not valid, the greatest possible 
Chapter/Verse will be opened. 
 
For example, if you have entered 57 for a chapter number in 
Genesis (50 chapters), the navigation system will sound a 
warning signal and Bible With You will open the last 
chapter of Genesis - 50.   
 
2. Graffiti Navigation System is automatically disabled 5 
seconds after you stop entering letters or digits. 
 
 

3. Examples  
 
3.1 Go to Proverbs 4:3, no matter where you are at the moment 

� Write the letter P on the Alpha Graffiti area 
� Tap on the abbreviation Pro in the list of Bible 

books abbreviations that appears at the bottom of 
the screen 

� Write the digit 4 on the Numeric area  
� Single tap on the Numeric area to confirm 
� Write the digit 3   

 

3.2 Go to Proverbs 4:23 – when you are in Proverbs 4:3 
� Single tap on the Numeric area  
� Write consequently the digits 2 and 3   

 
3.3 Go to Jude 24 

� Write the letter J on the Alpha Graffiti area 
� Tap on the abbreviation Jud in the list of Bible 

books abbreviations that appears at the bottom of 
the screen 

� Single tap on the Numeric area  
� Write consequently the digits 2 and 4 



 

3.6 Copying Verses 
Bible With You allows you to copy a single verse or a whole chapter to paste in 
other applications.  

3.6.1 Copying the Active Verse 
 

1. Activate a verse 
� Tap on the desired verse in the text  
Or 

� Select it as in 3.4 Reading the Bible 
 
The Active verse is the one that is displayed at the headline 
bar. Scrolling up/down the text does not change the active 
verse. 
 

2. Choose Copy Active Verse from the Edit menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on Edit 
� Tap on Copy Active Verse 

 
 
 
 
 
 

Or 
� Draw the Graffiti Menu Command stroke   to display the 

System Toolbar 
� Tap on the Copy icon 

 
Or 
� Tap on Copy icon in the Command Toolbar if it is shown 

 
Or 
� Draw the Graffiti Menu Command stroke   and write 

the letter E on the silkscreen 
 

3.6.2 Copying Verses 

This command allows you to copy all verses from the current selection – a whole 
chapter or a number of verses displayed from a cross reference. 

 
Warning: There might be problems with pasting larger 
passages in some applications (for example, Memo Pad). 
 

1. Choose Copy Verses from the Edit menu: 
� Tap on the Headline bar or the Menu button to 

display the form menu 
� Tap on Edit 

 

 

 

 



 

� Tap on Copy Verses 
       Or 

� Draw the Graffiti Menu Command stroke   to display the 
command toolbar 

� Tap on the Copy  icon 
 

Or 
� Draw the Graffiti Menu Command stroke   and write 

the letter V on the silkscreen 
 
 
 

3.6.3 Copying Highlight Bookmarks 
Bible With You allows copying Highlight Bookmarks 
(see section 3.10.) 
 
Important: All text that is part of the Highlight 
Bookmark will be added to clipboard – including the verse 
numbers, Strong’s numbers and numbers of the footnotes or 
references that may appear in the selection.   
 

1. Add Highlight Bookmark to a passage in the 
Bible 
� See how in 3.10 Highlight Bookmarks (Bookmark 

Passages) 
 
 
 
 
 
 
 
 

2. Choose Copy Highlight from the Edit menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on Edit 
� Tap on Copy Highlight 
Or 
� Draw the Graffiti Menu Command stroke   and write the 

number 8 on the silkscreen 
Or 

� Tap on Copy Highlight icon ( ) in the Command Toolbar 

 

 

 



 

3.7 History 
 
Bible With You keeps a history list of the passages you have visited allowing you to 
move back and forward in it. Thus you can read a passage from the Bible, then use 
an original language resource or a commentary book and with a single stroke return 
to the place in the Bible where you were. 
 
1. Go to the previous passage in the history list 

� Tap on the Headline bar or the Menu button to 
display the form menu 

� Tap on View 
� Tap on Previous 
Or 
� Draw the Backspace Graffiti Stroke on the silk screen 
Or 
� Select Backspace button in the Virtual or the 

Hardware Keyboard 
Or 
� Draw the Graffiti Menu Command stroke to display the 

command bar 
� Tap on the Back  arrow 
Or 
� Tap on the Back Arrow icon in the Command Toolbar if it 

is shown 
 
 

2. Go to the next passage in the history list 
� Tap on the Headline bar or the Menu button to 

display the form menu 
� Tap on View 
� Tap on Next 
Or 
� Draw the Space Graffiti Stroke on the silk screen 
Or 
� Select Space button in the Virtual or the Hardware 

Keyboard 
Or 
� Draw the Graffiti Menu Command stroke to display the 

command bar 
� Tap on the Forward arrow 
 
Or 
� Tap on the Forward  Arrow icon in the Command Toolbar 

if it is shown 

 
 
 

 

 

 

 

 

 



 

 

3.8 User Notes 
 
Bible With You allows you to attach and edit your personal notes to the active Bible 
verse. The attached note is being attached to the number of the verse and not to its 
text, and therefore, stays the same when you switch to another Bible translation.  
Only one Note may exist for a particular verse.    

3.8.1 Attaching Notes 

 
1. Attach a Note 

� Select a verse (See 3.5 Navigation in the Bible) 

� Tap on the Notes icon  in the Headline bar 
Or 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Edit Note 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

I on the silkscreen 
 

2. Enter your text 
� Use the Graffiti writing area or the System Keyboard 
 

3. Change the Note category 
� Tap on a Notes category displayed at the right top corner 

of the screen 
Or 
� Click on the Details button 
� Select a category from the Category list 
� Tap on OK 

 

3.8.2 Edit a Note 

You may edit a note, if one exists for a particular verse - 
Same as  

� Read 3.8.1. for how to open/edit a Note 
Or  
� Tap on the blue asterisk (*) at the beginning of the verse 

which indicates an existing Note to open the Edit Note 
form 

 
 
 
 
 
 
 
 

 

 



 

3.9 Verse Bookmarks 
Bible With You allows you to bookmark your favorite verses and organize the 
Bookmarks in categories.             

3.9.1 Adding Bookmarks 

1. Activate the desired verse 
� See 3.4 to learn how 
 

2. Choose Add to Bookmarks from the View menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Add to Bookmarks 
 
Or 
� Draw the Graffiti Menu Command stroke to display the 

command toolbar 

� Tap on the Add to Bookmarks icon  
Or 

� Tap on the  in the Command Toolbar if it is shown 
 
 
Or 
� Draw the Graffiti Menu Command stroke   and the 

letter O 
 

3.9.2 Managing Verse Bookmarks  

1. Choose Bookmarks from the View menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Bookmarks 
Or 
� Draw the Graffiti Menu Command stroke to display the 

command toolbar 

� Tap on the Bookmarks icon  
 
Or 

� Tap on the  in the Command Toolbar if it is shown 
 
Or 
� Draw the Graffiti Menu Command stroke   and the 

letter K 
 
Note: You need to have at least one bookmark in order to 
open the Bookmarks form.  

 
2. Select a bookmark 

 

 

 

 

 

 



 

� Tap on it in the list 
 

3. Edit a bookmark – you can change the name of the bookmark and the category it 
belongs 

� Tap on Edit 
 

3.1. Rename the bookmark 
By default, Bookmarks are entitled by the respective Bible 
book and chapter number.  
�  Enter the new name 

 

3.2. Change the bookmark’s category – you can choose the bookmark’s category 
from the list of current categories or create a new category. 

� Tap on the triangle button against Current category 
� Tap on a category in the drop down list 

 
4. View a bookmark 

� Tap on Go To 
Or  
� Tap on it again 
 

5. Delete a bookmark 
� Tap on Delete  
 

6. Exit to Bible text  
� Tap on Back 

 

3.9.3 Managing Categories for Verse Bookmarks 

1. Create a new category 
� Open the Bookmarks form (see how at 3.9.2) 
� Tap on Edit Categories... from the Category list 
� Tap on New 
� Enter the category name 
� Tap on OK 
 

2. Rename a category 
� Open the Bookmarks form (see how at 3.9.2) 
� Tap on Edit Categories... from the drop down list 
� Tap on Rename 
� Enter the new name 
� Tap on OK 

 
3. Delete a category 

� Open the Bookmarks form (see how at 3.9.2) 
� Tap on Edit Categories... from the drop down list 
� Tap on category 
� Tap on Delete 

 



 

3.10 Highlight Bookmarks (Bookmark Passages) 
 
Bible With You 7.23 allows you to add Highlight 
Bookmarks to passages in the Bible choosing colors for the 
font, background and the underline.  
 
Bible With You saves each Highlight Bookmark in a 
special category that has its own colors. This is extremely 
helpful when you want to have the Highlight Bookmarks 
on the same subject with the same colors. 
 
What is more, you can add your personal notes to each 
particular Highlight Bookmark. 
 
Warning: Highlight Bookmarks are being added to a 
particular Bible translation and may be used only with it. This 
is because the length of the passage that you bookmark 
depends on the exact wording of the text in the particular 
Bible translation. If you change the translation, the wording 
will be different, so the Highlight Bookmarks you have 
made and the notes that you have added for them will not 
apply to the new Bible translation.  

 

3.10.1 Turning Highlight Mode ON 

1. Activate Highlight Mode with icons: 
 
Highlight Mode is being used for adding Highlighted 
Bookmarks. 
 
Bible With You gives you the opportunity to change quickly 
between the standard Study mode and the Highlight 

mode via the  Study Mode / Highlight Mode selector. 
� Tap on the triangle  button in the Headline bar to 

open the Study Mode / Highlight Mode selector. 
 

A list with the most commonly used modes will be 
displayed: 
  
� Tap on one of the icons that are shown 
Or 
� Tap on the  button below to show all options for 

Highlight mode 
� Tap on one of the icons 
 
 
 
 
 

 



 

The icons in the Headline bar indicate the following: 

 - Bible With You is in the Standard/Study mode. 
Highlight Mode is OFF. 

 - Highlight Mode is ON. Highlighting will be by words and 
new highlights will be saved to current category. (‘W’ stands 
for highlighting Words, and ‘C’ for highlight category.) 

 - Highlight Mode is ON. Highlighting will be by letters and 
new highlights will be saved to current category. 

 - Highlight Mode is ON. Highlighting will be by words and 
Bible With You will ask you to which category each new 
highlights should be saved. 

 - Highlight Mode is ON. Highlighting will be by letters 
and Bible With You will ask you to which category each 
new highlights should be saved. 

 
 

2. Activate Highlight Mode from the View menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Highlight Mode 
Or 
� Draw the Graffiti Menu Command stroke   and number 

7 
 
 
 
 
 

3. Turn Highlight Mode ON: 
� Enable the checkbox before Enable in the Highlight 

Mode form 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 



 

4. Select preferences for the passages that you will 
bookmark: 
� Tap on the triangle next to Highlight to display the drop 

down list 
� Tap on by Words if you want to include text by words 
� Tap on by Letters if you want to include text by letters  

 
Points 5. and 6. show you a way to choose your preferences 
for Highlight Mode commands that is an alternative of the 

icons , , ,  from p.1.  
 
 

5. Select category for the current Highlight 
Bookmark 
� Tap on the triangle button below Add Bookmark: to 

display the drop down list 
� Choose an option from the list 

 
a) In current Category – Highlight Bookmarks will be 

added to to the current Bookmarks category 
 
b) Choose Category from the list - Bible With You will 

ask you to choose a category for each Highlight 
Bookmark you add. 

 
If no Bookmark categories were created, Bible With You 
will ask you to create one: 
� Tap on OK button in the alert message 

 
 
 
 
 
 
 
 

6. Create a new Bookmark category 
� Tap on the New button in the Edit Bookmarks 

Categories form 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 



 

7. Enter a name for the category 
� Tap on the Name field 
� Use Graffiti writing area or the device’s virtual/hardware 

keyboard to enter a name 
 

Note: Bookmark categories for the Highlight Bookmarks 
differ from the ones for Verse Bookmarks in this that they 
have options for choosing colors for the text, the background 
and for the underline. 

 
� Tap on the Text, Background or Underline button 

respectively 
� Enable the Text, Background or Underline checkbox 

to apply color on the text, on the background or to 
underline the highlighted passages  

 
 
 
 
 
Bible With You works with the standard controls of the 
device for choosing colors. 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

 

8.  Preview colors for the category: 
� See the sample text below Preview 

 
 

9.  Confirm  
� Tap on OK button 

 
 
 
 
 
 
 
 

 

 

 

 



 

 

3.10.2 Add Highlight Bookmarks 

 
1. Select passage: 

� Tap and drag with the stulys in the text to mark the word 
or the passage that you would like to highlight 
 
 
 
 
 
 
 
 
 

Note: If you want to make a larger selection, drag with the 
stylus to the bottom of the screen and hold it on the 
Command toolbar till the desired passage is selected. 

 
 
 
 
 
 
 
 
 

2. Add select passage as Highlight Bookmark 

� Tap on the  icon in the Command Toolbar 

Notes: The colored square of the  icon indicates the colors 
of the current category for Highlight Bookmarks. 

 
 
 
 
 

3.10.3 Copying Highlight Bookmarks 

1. Copy Highlight Bookmarks 
� See how in 3.6.3 Copying Highlight Bookmarks  

 
 
 
 
 
 
 
 

 

 

 



 

3.10.4 Adding notes to Highlight Bookmarks 

 

1. Open the Bookmarks form: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Bookmarks 
Or 
� Tap on the Bookmarks icon  in the Command Toolbar 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

K 
 

2. Select Bookmark category: 
� Tap on the triangle button after Current 
� Tap on a category in the list 

 

Note: Categories of the Highlight Bookmarks are denoted 
by the abbreviation of the Bible translation for which they 
were made. 

 
 
 
 

3. Select a Highlight Bookmark from the list: 
� Tap on a Bookmark in the list 
� Tap on Edit button 

 

Note: Highlight Bookmark are stored in special bookmark 
categories which are denoted by the abbreviation of the Bible 
translation for which they were made. 

 
 
 
 
 

4. Enter text for the note: 
� Use Graffiti writing area or the device’s virtual/hardware 

keyboard 
� Tap on OK 

 

 
 
 
 
 
 

 

 

 

 



 

3.10.5 Viewing notes to Highlight Bookmarks 

Notes to Highlight Bookmarks are displayed in pop-up 
windows. 

1. Choose Standard / Study Mode : 
� See how in 3.10.1 
 

2. Go to a Highlight Bookmark 
� Use the scroll bar or the Page Up/Down buttons 

 
 
 

3. Open a note to a Highlight Bookmark 
� Tap with the stylus on the highlighted text (but not on a 

Strong’s number, footnote or cross reference) 
 

Note: Tapping on a Strong’s number, a footnote or a cross 
reference will open a pop-up with the information they 
provide. 

 
4. Close pop-up with note: 

� Tap anywhere on the screen 
 
 

 

3.10.6 Activating verses in highlighted passages 

 
Since tapping on highlighted passages in Study Mode opens 
the notes that were added to them, activating the verse is 
slightly different for them. 
 

1. Choose Standard / Study Mode : 
� See how in 3.10.1 
 

 

2. Activate a verse: 
� Tap with the stylus on the number of the verse  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 



 

3.10.7 Change current Highlight Bookmark category 

 

1. Open the Bookmarks form: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Bookmarks 
Or 
� Tap on the Bookmarks icon  in the Command Toolbar 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

K 
 
 
 

2. Change the category: 
� Tap on the triangle next to Current: 
� Tap on another category from the list 
� Tap on Back 

 
Note: The category has been changed. Next highlights will 
be with the color of the selected category. 

 
 
 
 
 

3.10.8 Edit Current Highlight Bookmark Category 

 
1. Open the Edit Bookmark Category form: 

� Tap on the Edit Bookmark Category  icon in the 
Command Toolbar 
 

 
 
 
 
 

 
 

2. Edit name and/or colors of current category: 
� See how in section 3.10.1 

 
Note: This action will change the colors of all existing 
Highlight Bookmark from the category that you edit. 

 
 
 
 
 
 

 

 

 

 



 

 

3. Hiding the colors of all passages in a category: 
� Disable the checkbox before Highlight Bookmarks in 

Category 
 

 
 
 
 
 
 
 
 

3.10.9 Moving to Previous/Next Highlight Bookmark 

Bible With You allows you to move to the Previous or Next 
Highlight Bookmarks while in the Highlight Mode. You can do 
this either in the current Highlight Bookmark category or in 
the full list of Highlight and Verse Bookmarks. 
 

1. Moving to the next/previous Highlight Bookmark in 
the current Bookmark category: 

� Tap respectively on the Back ( ) or Forward ( ) icons in 
the command toolbar   
 

The text will be positioned on the previous or the next 
Highlight Bookmark from the same category. It will be 
selected so you can immediately copy it.  

 

Colors in the  icon indicate that you are viewing the 
Highlight Bookmark from the current Bookmark category. 

 
 

2. Moving to the next/previous Highlight Bookmark in the 
complete list of highlighted passages: 

� Tap on  icon in the command toolbar to change to 
moving to all categories 

Colors in the  icon will disappear - . 
 
� Tap respectively on the Back ( ) or Forward ( ) icons in 

the command toolbar   
 
The text will be positioned on the previous or the next 
Highlight Bookmark from the complete list of Bookmark 
categoris. It will be selected so you can immediately copy it. 
 
 
 
 
 

 

 

 



 

3. Changing between the above two modes: 

� Tap on the  icon in the command toolbar to change 

it to  and vice versa 
 

3.10.10 Sorting Highlight Bookmarks 

Bible With You allows you to sort all Verse and Highlight 
Bookmarks that you have made or only those from 
particular category by their names or by the verses to which 
they are assigned.  
This option may be used when you want to move to the 
next/previous Highlight Bookmark either by verse order 
or by name of the Highlight Bookmark. 
 
Warning: When you add new Highlight Bookmarks or 
edit others, you will need to sort them again. 
 

1. Open the Bookmarks form: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Bookmarks 
Or 
� Tap on the Bookmarks icon  in the Command Toolbar 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

K 
 

 
 

2. Choose category in which you want to sort: 
� Tap on the triangle button next to Current 
� Tap on a category in the list 
 

 

3. Choose an option for sorting: 
� Tap on or By Name radio buttons to enable an option 
� Tap on OK 

 
 
 

In this example, the Highlight Bookmarks from the current 
category have been sorted by their Names. 
 
 
 

 
 
 
 
 

 

 

 



 

 

3.10.11 Deleting Highlight Bookmarks 

1. Open the Bookmarks form: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Bookmarks 
Or 
� Tap on the Bookmarks icon  in the Command Toolbar 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

K 
 

2. Select the Highlight Bookmark you want to 
delete  
� Tap on a Highlight Bookmark in the list of Bookmarks 
� Tap on the Del button 

 

3.10.12 Deleting Categories for Highlight Bookmarks 

 
1. Open the Bookmarks form: 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on View 
� Tap on Bookmarks 
Or 
� Tap on the Bookmarks icon  in the Command Toolbar 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

K 
 

2. Select category to delete  
� Tap on the triangle next to Current 
� Tap on Edit Categories 
 

3. Delete a category  
� Tap on a category in the list 
� Tap on Delete  

 
 
 
 
 
 
 
 
 
 

 

 

 



 

3.10.13 Turning Highlight Mode OFF 

 

1. Choose Highlight Mode from the View menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 
� Tap on Highlight Mode 

 
 
 
 
 
 

2. Turn Highlight Mode off: 
� Disable the checkbox before Enable in the Highlight 

Mode form 
� Tap on OK button 

Or 

3. Choose Standard / Study Mode : 
� See how in 3.10.1 

 

 

 

 

 



 

3.11  Searching for words and phrases in the Bible 
 
Bible With You does not support its own search engine. However, it is closely 
integrated with another GMPSoft application you need to install separately, Bible 
Concordance With You, a powerful electronic concordance allowing you to search 
for words, phrases and even Strong’s numbers in the Bible.  
 
The application provides AND, OR, NOT, Wildcard, Phrases search, search in 
specified books of the Bible, Show Verse Excerpt, Show Verse Protocol via 
launching Bible With You and other features.  
 
Note: Bible Concordance With You requires a separate License.  
  
Searches in Bible With You are implemented by Bible Concordance With You 
application which supports the Show Verse Protocol (See Section 7). 
 

3.11.1 Get Bible Concordance With You 

Download the product and order a License for it from 
GMPSoft’s site: www.gmpsoft.com 

3.11.2 Launch Bible Concordance With You 

 
1. Choose Search from the Edit menu 

� Tap on the Bible With You bar or the Menu button to 
display the form menu 

� Tap on Edit 
� Tap on Search 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

S on the silkscreen 
 
 

3.11.3 Perform search with Bible Concordance 
With You 

 
See how in Bible Concordance With You’s User Guide:  
http://www.gmpsoft.com/download/src/pdf/UserGuide(C).pdf 

 
 
 
 
 
 

 

 



 

3.12 Footnotes 
 
Bible With You displays the footnotes available in some 
of Bible databases. 
 
For more convenience the footnotes are displayed as pop-
ups and not below the text. 
 
1. View a footnote 

� Tap on the footnote number in square brackets in 
superscript 

 
2. Close a footnote pop-up 

� Tap inside the footnote pop-up or anywhere on the 
screen  
 
 

3.13  Cross References 
 
Bible With You displays the cross references available in 
some translations of the Bible. Cross references are links 
in the text to other verses in the Bible.  
 
Cross references are provided by another GMPSoft 
product, Bible Cross References, which is a database 
plug-in for Bible With You.  
 

Get Bible Cross References from GMPSoft’s Products page: 
http://www.gmpsoft.com 

 
Notes:  
Cross References are indicated by a number in round 
brackets in the text and displayed in pop-up windows. 
 

1. Show/Hide cross reference 
� Read the instructions in the User Guide of Bible 

References 
Or 
� Draw the Graffiti Menu Command stroke to display the 

command toolbar 
� Tap on R  icon  
Or 
� Tap on R  icon in the Command Toolbar if it is shown 
 

 
 

 

 

 

 



 

2. Display a cross reference 
� Tap on the reference number closed by round brackets 

in superscript 

 
3. View passages in a cross reference – works as a hyperlink 

� Tap on the text in the cross reference pop-up 
Note: You can return to the initial passage with the Back 
button 

 
4. Close pop-up with cross references 

� Tap on a blank space inside the cross reference pop-up 
 
 

3.14  Strong’s Numbers 
 
Bible With You visualizes the Strong’s numbers provided by some Bible 
translations. To use Strong’s numbers, you need to install Bible With You for a 
translation that supports them indicated by wS in the product title – for example: 
Bible With You (KJVwS). 
 
Notes:  
1. Strong’s numbers are indicated by braces in the text. 

You may choose between displaying the Strong’s numbers in 
the braces and displaying only the marks (braces). 

 
2. To use definitions it is necessary to install a compatible 
Hebrew/Greek lexicon. 

Get Hebrew/Greek Lexicons from GMPSoft’s Products page: 
http://www.gmpsoft.com 

 
3. Strong’s definitions of the original words are displayed 
in pop-up windows.  
 
1. Select Show/Hide Strong’s Numbers/Marks 

� Adjust Show Strong’s Numbers/Marks in the 
Preferences form (see section 3.2 Adjusting the 
preferences) 

Or 
� Draw the Graffiti Menu Command stroke to display the 

command toolbar 
 
� Tap on the S icon to alternatively display Strong’s 

numbers in the text, show only Marks (braces) or hide 
Strong’s numbers. 

Or 
� Tap on S  icon in the Command Toolbar if it is shown 
 

 

 

 



 

 
2. View Strong’s numbers and definitions 

� Tap on the Strong’s number inside the braces or, if 
only Marks are displayed, inside the braces. 

 

3. View a Strong’s number in the definition 
� Tap on it in the definition text in the pop-up 

 
Note: The definition will be displayed in a new pop-up 
window. 

 
4. Close pop-up with number and definition 

� Tap inside the pop-up 
 

3.15 Greek New Testament with Tagging 
 
Warning: This feature requires Bible Bundle (Greek UBS4) for the Greek New 
Testament, Nestle-Aland 27th Edition and the OakTree GNT Morphology database.  
 

Get Bible Bundle (Greek UBS4) from: 
http://www.biblewithyou.com 

The OakTree GNT morphology includes the lexical form and parsing information 
for each Greek word in the UBS4/Nestle27 Greek text, along with a brief English 
definition.  The morphological tagging was initially performed by Dr. Bill Mounce, and 
has subsequently been improved and corrected by Dr. 
Rex A. Koivisto. 

1. Choose Bible… from the Book menu: 
� Tap on Bible bar or Menu button to display the form 

menu 
� Tap on Book 
� Tap on Bible… 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

B on the silkscreen 

 
2. Activating the morphology: 

� Enable the check box before Bible 
� Tap on the Greek New Testament 
� Enable the check box before the OakTree GNT 

Morphology 
 

 
 
 
 

 

 

 



 

5. Open pop-up with tagging information 
� Tap on a word in the text 
 
Note: A pop-up window with the tagging information about 
the original Greek word will appear. 
 
The tagging information includes grammatical analysis and 
definition of the word.  

 
 
 
 
6. Close a pop-up window 

� Tap anywhere on the screen with the stylus 

 
 

 
 
 
 
 
 

3.16  Book Introductions 
Bible With You implements the Book introductions provided by certain Bible 
translations. The introduction is indicated by an icon in the Headline bar. 
 
1. Display Book Introductions 

� Tap on the  icon in the Headline Bar 
 

 

 

 

 



 

 

3.17  Bible Images 
Bible With You gives you the possibility to view images related to certain books, 
chapters or verses in the Bible while reading the text. In order to view images, you 
need to install and activate a database of Bible Images product, which is 
distributed apart from Bible With You and requires a separate License.  

Get Bible Images from www.gmpsoft.com 

 
1. View an image to a Bible verse 

� Tap on the camera icon  in the Headline bar next to 
the verse 

 
 
2. View next image to the same Bible verse 

For some of the verses there may be a number of related 
images. 
� Tap on the Forward arrow in the Headline bar to move 

to the next image 

 
The Image’s Title is displayed in the Headline Bar. 

 
Image orientation: In order to view some of the images 
properly, you need to rotate your device. The images’ 
orientation is indicated by the Portrait or Landscape icon in 
the Headline bar before the Image’s Title.  
 

   - The image is orientated properly on the screen.  
 

 - The icon suggests that you need to rotate your Palm 
device in order to view the image properly. 
 
 
 

3. Display image’s description  
Some of images have a brief description, which is displayed in 
a pop-up window. 
� Tap on the Image’s Title in the Headline bar to display 

the definition pop-up. 

 
 
 
 
 
 
 

 

 

 



 

 
4. Go to the next verse that is illustrated by an image  

� Tap on the Headline bar or the Menu button to display 
the menus 

� Tap on Edit 
� Tap on Next Imaged Verse 
 
The Bible text will be moved to the next verse associated with 
an image(s). It will become the active one. 

 
5. Return to the Bible text 

� Tap on the Dove icon in the Headline bar 
 

 



 

 
 

4 Comparison Study Mode 
Bible With You allows you to read and compare verses 
of two Bible translations in split screen mode.  
In order to use this feature you need to install Bible With 
You for at least two Bible translations.  

Get more Bible translations from www.gmpsoft.com 
 
The screen in the Comparison Study mode is split in 
two and the two Bible translations appear in the two 
sections of the screen.  

 

4.1 Select a Bible for the upper window 
 
The same as Select a Bible translation (See section 3.1 for 
instructions) 
 

The name of the Bible translation in the upper window is 
displayed at the Menu bar  
 
 
 
 
 

4.2 Select a Bible for the bottom window 
 

1. Open the Select Books form 
� See section 3.1 for instructions 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

C on the silkscreen 
 

2. Scan for new Bible translations  
� See section 3.1 for instructions 
 

3. Choose a Complementary Bible translation 
� See section 3.1 for instructions 
  
Choosing a Bible for the bottom window automatically sets 
the Comparison Study Mode. 

 
 

 

 

 



 

 

4.3 Navigation in the text 
1. Move the text 

� Use the respective scroll bar to move the text up and 
down in each window.  

Or  
� Move the Sony Jog Dial up/down –the text in both 

windows will move per one line 
Or  
� Push Sony Jog Dial wheel and move it up/down - the text 

in the two windows will move synchronically one verse at 
a time. 

2. Synchronize a verse in both windows 
� Tap on the verse you want to make active 
 
Both Bibles will synchronically display the active verse at the 
top of their windows and the active verse will be displayed at 
the Menu bar  

4.4 Hide Complementary Bible 
 
1. Hide Complementary Bible  

� Tap on the  button in the Complementary Bible 
window 

2. Show Complementary Bible 
� Tap on the   button at the bottom of the scroll-bar  

 

4.5 Select a book, chapter and/or verse to 
compare 

1. Same as in 3.5 Navigation in the Bible Navigation in the  
� Follow the instructions in section 3.5 Navigation in the 

Bible Navigation in the  
Selected verse will be synchronically displayed by both Bible 
versions 

4.6 Return to Study mode 
1. Choose Complementary Bible from the Book menu: 

� Tap on the Headline bar or use the Menu button to 
display the form menu 

� Tap on Book 
� Tap on Complementary Bible 
Or 
� Draw the Graffiti Menu Command stroke   and the 

letter C on the silkscreen 

2. Deselect Bible translation: 
� Disable the Complementary Bible checkbox 

 

 



 

3. Confirm 
� Tap on the Done button 

5 Reading Mode 
 
The Reading mode of Bible With You is especially designed to enhance your 
reading experience allowing you to define a set of reading preferences (font size 
appropriate for reading longer passages, hiding Strong’s numbers, footnotes and 
references). Thus, next time you decide to read the Bible (whether following a plan 
or not) you will already have your reading preferences saved and you will fully 
concentrate on the reading without loosing time in changing preferences from study-
friendly to reading-friendly. Using the Ribbon feature you can easily follow a Bible 
reading plan. The navigation in the Reading mode is designed to help you fully 
concentrate on the reading process, especially the Auto Scroll and the Screen 
Wrap modes. 

5.1 Adjusting the Reading Mode Preferences 
Bible With You allows defining different sets of preferences for reading and for 
studying the Bible (see 3 Study Mode). For example, you could have Strong’s 
numbers disabled in the Reading mode, and enabled in the Study mode, applied 
bold formatting in the Reading mode. 
 
1. Open the Preferences form 

� Tap on the Bible With You bar or use the Menu button 
to display the form menu 

� Tap on Read 
� Tap on Preferences… 
 
 
 

 
 
 
2. Select a Reading mode option – these options 
refer to the navigation. In Manual mode you use 
the Page Down button to scroll down, while in  
Auto Scroll and Screen Wrap modes the text 
moves down automatically, you only adjust the 
speed. 

� Tap on the down arrow on the left of Reading Mode 
field  

� Tap on Manual, Auto Scroll or Screen Wrap 
 
 
3. Text size – Medium or Larger are suitable for reading 

� Tap on the down arrow next to the Text size field  

 

 



 

� Choose a text size from the drop down list 
 

 
4. Apply bold formatting to text – enabling of this option is recommended for the 

Auto Scroll and the Screen Wrap modes 
� Enable Apply Bold Formatting check box  
 

5. Hide Strong’s Numbers – disable this option to better concentrate on the text 
you read 
� Disable the Show Strong’s check box 
  

6. Show/hide footnotes – enable this option if you want to look at the footnotes 
while reading 
Note: Works only for Bible versions providing footnotes 
� Tap on Show footnotes check box to change 

alternatively its state 
Or 
� Draw the Graffiti Menu Command stroke to display the 

command toolbar 
� Tap on the F  icon  
 
 

7. Hide references - it is recommended this option to be disabled in Reading 
mode 

 
� Tap on Show references check box to change 

alternatively its state 
Or 
� Draw the Graffiti Menu Command stroke to display the 

command toolbar 
� Tap on the R  icon  
 

8. View last line 
This feature allows you to vie the last line of the previous 
page when paging down the text. 
 

9. Apply the Preferences 
� Tap on OK 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



 

 
 

5.2 Reading the Bible 
1. Initiate Reading 

� Tap on the Headline bar or use the Menu button to 
display the form menu 

� Tap on Read 
� Tap on Start Reading 
Or 
� Tap on the  icon if you have selected a ribbon to 

continue reading (See 5.3 Ribbons) 
 

 
2. Exit the Reading mode 

� Press anywhere on the screen - you could do this 
even by tapping on the screen with your thumb. 

 

5.2.1 Auto Scroll Mode 

The text in Auto Scroll mode is being smoothly auto scrolled up. The user may 
adjust the speed of scrolling or pause the auto scroll. 
 
1. Initiate Reading 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on Read 
� Tap on Start Reading 
Or 
� Tap on the  icon if you have selected a ribbon to 

continue reading (See 5.3 Ribbons) 
 
2. Increase speed  

� Press and hold the Page Down button until you reach 
the desired speed 

Or 
� Roll the Sony Jog Dial wheel Downward 
 

3. Decrease speed  
� Press and hold the Page Up button until you reach the 

desired speed 
Or 

� Roll the Sony Jog Dial wheel downward 
 

4. Pause 
� Press and hold any of the rest Hardware Buttons 

(Launcher, Menus, Calculator, Find ) 
Or 

� Press and hold the Sony Jog Dial wheel  
 

 

 



 

5. Determine the most appropriate speed: 
� Go to a verse you would like to start from  
� Start reading (see point.1)  
� if you manage to read the text until under 2-3 lines 

from the centre of the page, press Page Down 
button to accelerate.  

� Repeat, until you keep reading the text in the 
centre.  

� Best speed for you is the one at which you read the 
text close to the centre  

 
Notes: 
 1. If you have lost concentration, just pause Autoscroll.  
 
2. Once you have determined the appropriate for you speed, 
you need only to use the buttons for Pausing, when you 
need to stop for a while.   
 
3. If you change any of the Preferences (for example text 
size), repeat the procedure to obtain the most appropriate 
speed for the new preferences. If necessary, press Page Up 
beforehand to decrease the speed. 
 

6. Exit the Autoscroll mode 
� Press anywhere on the screen - you could do this 

even by tapping on the screen with your thumb. 
                     

5.2.2 Screen Wrap Mode 

 
In the Screen Wrap mode, next page is being smoothly 
rolled down from the top of the screen, while the user is 
reading the current page. The user may adjust the speed 
of updating of the screen or may just pause. 
1. Initiate Reading 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on Read 
� Tap on Start Reading 
Or 
� Tap on the  icon if you have selected a ribbon to 

continue reading (See 5.3 Ribbons) 
 
2. Increase speed  

� Press and hold the Page Down button until you reach 
the desired speed 

Or 
� Roll the Sony Jog Dial wheel downward 
 

3. Decrease speed  

 



 

� Press and hold the Page Up button until you reach the 
desired speed 

Or 
� Roll the Sony Jog Dial wheel downward 

 

4. Pause 
� Press and hold any of the rest Hardware Buttons 

(Launcher, Menus, Calculator, Find ) 
Or 

� Press and hold the Sony Jog Dial wheel  
 

5. Determine the most appropriate speed: 
� go to a verse you would like to start from  
� Start reading (see point.1)  
� If you are reading too close above the horizontal 

line, accelerate with the Page Down button 
� If you are reading too close under the horizontal 

line, slow down with the Page Up button 
 
 
 
Notes:  
1. Try to keep reading not too close to the horizontal line.   
2. Disregard the moving of the horizontal line for better 

reading. 
3. If you have lost concentration, just pause Screen 

Wrap.  
 

4. Once you have determined the most appropriate speed, 
you need only to use the buttons for Pausing, when you 
need to stop for a while.   
 

5. If you change any of the Preferences (for example text 
size), repeat the procedure to obtain the most 
appropriate speed for the new preferences. If necessary, 
press Page Up beforehand to decrease the speed. 

 
 

 

5.2.3 Manual Mode  

In the Manual mode, the user scrolls the text manually one page/line up with the 
help of the hardware buttons or the Sony Jog Dial wheel. 
 
1. Move the text per line  

� Roll the Sony Jog Dial wheel downward 
 

2. Move the text per page 
� Press Page Down hardware button 
Or 
� Roll the Sony Jog Dial wheel Downward 

 



 

 

3. Exit the Manual reading mode 
� Press anywhere on the screen - you could do this 

even by tapping on the screen with your thumb  
 

5.3 Ribbons 
Bible With You allows you to add user marks, called ribbons, in Reading mode 
(see) to save the last passage read in a certain Bible book. Next time Bible With 
You is used, the you may continue reading this book from the same place. You can 
add an unlimited number of ribbons in order to keep track of the reading progress in 
different parts of the Bible. For example, different ribbons may be added for a book 
in the OT, in the NT, for a poetical book, etc and thus you can easily follow a reading 
plan.  
 
Important: In order for ribbons to save the last passage you have read from a particular 
selection, you need to activate Reading Mode (see 5.2).    

5.3.1 Add a Ribbon 

 
� Select the Bible book, chapter and verse, from which you 

would like the ribbon to start. 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on Read 
� Tap on Add Ribbon 
 
 

      

5.3.2 Go To a Ribbon 

Opens Bible With You on the last passage read in the 
Book, where you have the Ribbon attached. 

 
1. Open Ribbons form 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on Read 
� Tap on Ribbons 
 

       
2. Select a Ribbon from the list 

� Tap on one in the list 
 
3. Go to the text  

� Tap on Go To button 
 

4. Start Reading mode 

 

 



 

� See 5.2 Reading for instructions  
 
 

5. Exit Reading Mode  
� See 5.2 Exit the Reading mode for instructions  

 
Note: When you exit the Reading mode, the Ribbon will 
save the information about the last passage you have read. 
 
 
 
 

5.3.3 Edit a Ribbon 

Allows you to edit the Ribbon anchor and its title.                     
 
1. Open Ribbons form 

� Tap on the Headline bar or the Menu button to 
display the form menu 

� Tap on Read 
� Tap on Ribbons 

       
2. Select a Ribbon  

� Tap on one in the list 
 

3. Open the Edit Ribbon form 
� Tap on the Edit button 

 
4. Edit Ribbon anchor 

� Tap on the Book name in the Ribbon at field 
This will open the Select Book form Select Book, chapter 
and verse (See 3.5.1 Form navigation) 

 
5. Edit a Ribbon name 

� Enter a new name in the Name field using the 
Graffiti area or the Virtual Keyboard 

 

6. Confirm 
� Tap on the OK button 

         

5.3.4 Delete a Ribbon 

� Tap on the Delete button in the Ribbons form 
 
 
 
 
 
 
 

 



 

 
 
 

5.4 Auto Off  Power 
Palm PDAs have very short intervals for auto-powering off.  
To give you more time for continuous reading, Bible With You overrides these 
settings in the Reading mode.  
 
To prevent your battery from draining, a warning 
message will be displayed 20 minutes after you have 
started any of the Reading modes.    
 
1. Continue your reading:  

� Tap on OK button 
 

2. Leave Reading mode  
� Tap on STOP button 

         
If you don’t choose either option within the time interval set for Auto-off in your 
device’s preferences, the Reading mode will be exited and your device will be 
Powered Off.  
 
 

 



 

6 Study Books 
Bible With You integrates a number of additional books for studying the Bible – 
original language resources, cross-references, commentaries, lexicons, dictionaries, 
images, etc.  
 
Study Books are database add-ons for Bible With You and are separate GMPSoft 
products purchased apart from the application.  
 
Some of them - like commentary books and dictionaries, are independent from the 
current Bible translation. Others require a special type of a Bible translation – for 
example, Hebrew/Greek lexicons must be installed if there is installed a Bible 
translation that supports Strong’s numbers. 
 
For more information about each Study Book, read its product description and its 
User Guide. 

6.1 Cross References 
 
Bible With You supports cross references in the text - links in the text to other 
verses in the Bible.  
 
Cross references have been released for only a number of Bible translations and are 
associated with a particular Bible translation -for example, cross references for the 
NASB Bible, for the ESV Bible, etc. 
 
The information about cross references in Bible With You is provided by separate 
GMPSoft add-on products, Bible Cross References.  
 
When Bible Cross References are activated for the matching Bible translation (for 
example, Bible Cross References (NASB) in Bible With You (NASB)), cross 
reference numbers are displayed at the exact places in the verses. 
 
If they are activated for another Bible translation (for example, Bible Cross 
References (NASB) in Bible With You (ASV)), cross reference numbers are 
indicated in the beginning of the verse.  
 
1. How to use cross references   

� See section  3.13 

 
 



 

6.2 Hebrew/Greek Lexicons 
Hebrew/Greek Lexicons are add-ons for Bible With You providing information 
about the original Hebrew and Greek words, which are indicated by Strong’s 
numbers in the text. Because of that, they require Bible translations which include 
the Strong’s numbers in the text – the product title includes wS: Bible With You 
(KJVwS). 
 

For available Hebrew/Greek Lexicons check our site: 
www.gmpsoft.com  

 
1. View Strong’s definitions  

� See section 3.14 

6.3 Commentaries  
Get Bible Commentaries With You from our website: 
www.gmpsoft.com 
 
Notes:  
- When a commentary book is installed, Bible With You will 
display the B, C or V icon selector in the Headline bar 

( ). The B, C and V icons indicate commentary entries 
for the current Book, Chapter or Verse in the Bible. 
 
- Some commentary books may provide entries only for 
verses in the Bible or for verses and chapters. This depends 
on the particular resource that is used. 

 
1. Go to a verse in the Bible 

 

2. Select to read commentary entry to the current 
Book, Chapter or Verse 
� Tap on the  button in the Commentary selector icon 

 
 
3. View commentary 

� Tap on one of the icons - B, C or V that will be displayed 
 

4. Read commentary 
� Use the Scroll Bar or Hardware buttons 

 
5. View a cross reference  

� Tap on a cross-reference link in the text 
 

6. Exit the commentary book 

� Tap on the  shortcut icon on the Headline toolbar 
 

 

 

 

 



 

6.4 Dictionaries 
Dictionaries are add-ons for Bible With You, providing pop-up definitions for 
words in the Bible. Dictionaries may be used with Bible With You for any Bible 
translation. Dictionaries With You are separate GMPSoft products and require a 
separate License.  

For available Bible dictionaries check: www.gmpsoft.com 
For available Oxford dictionaries check: www.reftogo.com 
  

1. Select Dictionaries 
� See how in 3.1 Select a Bible translation 

 
2. Go to a verse in the Bible 

� See how in 3.4 Reading the Bible 

 
 
3. Show a definition pop-up  

� Tap and hold the stylus on a word 
 
A list of the word’s definitions available in different 
dictionaries will be shown 
 

4. Show a definition in one of the dictionaries 
� Tap on the hyperlinked word listed under one of the 

dictionaries 
 
5. Exit the definition pop-up 

� Tap on a blank space in the pop-up or on the Bible text 
 

 

 



 

7 Show Verse Protocol 
 
Bible With You is integrated with a number of other PDA applications. The Show 
Verse Protocol feature, provided by Bible With You, allows the other applications 
to start Bible With You to visualize the Bible text. A shortcut icon allows you to 
return from Bible With You directly to the launcher application. 
  
1. Return to the launcher application  

� Tap on the shortcut icon in the headline bar  
 
 
 

 



 

8 Contact and support 
 
Technical Support 
In order to report problems or ask questions with regard to the software, contact our 
Technical Support Department: 
E-mail: support@gmpsoft.com 
 
Sales 
In order to obtain general information or product and sales related information, 
contact our Sales Department: 
E-mail: sales@gmpsoft.com 
Sales points: www.gmpsoft.com, www.palmgear.com, www.pdassi.de  
 
Partnership and Business Development 
In order to enquire about partnering and B2B development, contact our Management 
Department: 
E-mail: ceo@gmpsoft.com 
 
 
For detailed information on GMPSoft’s products, sales and registration, or for 
technical support, check our web site: www.gmpsoft.com  
 
 



 

9 Copyright and Usage Information 
This PDA software product and the algorithms used are property of GMPSoft. All 
rights reserved 2002-2007. 
 

About the Bible Translations 

9.1 A Conservative Version (ACV)  
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 

9.2 American Standard Version (ASV) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 

9.3 American King James Version (AKJV) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 

9.4 Bible in Basic English (BBE) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 

9.5 Complete Jewish Bible (CJB) 

a. Copyright 
Complete Jewish Bible © 1998 by David H. Stern.  
Published by Jewish New Testament Publications, Inc., P.O. Box 615, Clarksville, MD 21029, phone (410) 764-
6144, website: www.messianicjewish.net/jntp. Distributed by Messianic Jewish Resources Int'l, website: 
www.messianicjewish.net. All rights reserved. Used by permission.  
 
b. Usage Information 
The text of the Complete Jewish Bible may be quoted or used in a print publication up to and inclusive of one 
hundred (100) verses without the express written permission of the publisher, provided that the verses quoted do 
not account for more than ten percent (10%) of the work in which they are quoted, and provided that a complete 
book of the Bible is not quoted.  
 
The text of the Complete Jewish Bible may not be altered or adapted. All quotations must be completely accurate 
to the text of the Complete Jewish Bible, including punctuation, capitalization, italics etc., unless approval from 
the publisher is granted in writing before publication (see below).  
 
When the Complete Jewish Bible is quoted, the following notice must appear on the copyright page of the work:  
 
Scripture quotations are taken from the Complete Jewish Bible, copyright © 1998 by David H. Stern. Published by 
Jewish New Testament Publications, Inc. www.messianicjewish.net/jntp. Distributed by Messianic Jewish 
Resources. www.messianicjewish.net. All rights reserved. Used by permission.  
When quotations from the Complete Jewish Bible text are used in congregational bulletins and orders of service, 
a complete copyright notice is not required, but the words Complete Jewish Bible must appear at the end of each 
quotation.  
 
Publication of a commentary or other Bible reference or theological work produced that uses the Complete Jewish 
Bible must have written permission of the publisher.  



 

 
Quotations in excess of one hundred (100) verses or ten percent (10%) of the work and all other types of 
permission requests (including internet and electronic media) must be directed to: Permissions Department, 
Jewish New Testament Publications, Inc., P.O. Box 615, Clarksville, MD 21029, and approved in writing. Please 
include an e-mail address in all correspondence. 
 

9.6 Contemporary English Version (CEV) 
a. Copyright 

 
Contemporary English Version (CEV) © 1991, 1995 by American Bible Society. Used by permission. All rights 
reserved.  
 

b. Permission to Quote CEV 
 
Bible text from the Contemporary English Version (CEV) is not to be reproduced in copies or otherwise by any 
means except as permitted in writing by American Bible Society, 1865 Broadway, New York, NY 10023.  
 
The CEV text may be quoted in any form (written, visual, electronic or audio) up to & inclusive of five hundred 
(500) verses without written permission, providing the verses quoted do not amount to 50% of a complete book 
of the Bible nor do the verses account for twenty-five percent (25%) or more of the total text of the work in 
which they are quoted. This permission is contingent upon an appropriate copyright acknowledgment. 
 

9.7 Darby Translation  
This work is a courtesy of Paul W. Esposito, and Stauros Ministries. 
 

9.8 Elberfelder Bibel 1905 (EB1905) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.9 Die Elberfelder Bibel 1985 (EB1985) 
Die Bibel 
Elberfelder Übersetzung, revidierte Fassung 
© 1985/1991 R. Brockhaus Verlag Wuppertal 
 

9.10 English Majority Text Version (EMTV) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.11 Holy Bible: Easy To Read Version 
 
Holy Bible: Easy to Read Version 
Copyright © 2004 by World Bible Translation Center. 
All rights reserved. 
 

9.12 English Standard Version 
a. Copyright 

 



 

The Holy Bible, English Standard Version™ 
Copyright © 2001 by Crossway Bibles, a division of Good News Publishers. 
All rights reserved.  
 

b. Permission to Quote ESV 
 
The ESV text may be quoted (in written, visual, or electronic form) up to and inclusive of one thousand (1,000) 
verses without express written permission of the publisher, providing that the verses quoted to not amount to a 
complete book of the Bible nor do the verses quoted account for 50 percent or more of the total text of the work 
in which they are quoted.  
 
The ESV text may be quoted for audio use (audio cassettes, CD's, audio television) up to two hundred fifty (250) 
verses without express written permission of the publisher providing that the verses quoted do not amount to a 
complete book of the Bible nor do the verses quoted account for 50 percent or more of the total text of the work 
in which they are quoted.  
 
Notice of copyright must appear as follows on the title page or copyright page of printed works quoting from the 
ESV, or in a corresponding location when the ESV is quoted in other media:  
"Scripture quotations are from The Holy Bible, English Standard Version, 
copyright © 2001 by Crossway Bibles, a division of Good News Publishers. 
Used by permission. 
All rights reserved."  
When more than one translation is quoted in printed works or other media, the foregoing notice of copyright 
should begin as follows:  
"Unless otherwise indicated, all Scripture quotations are from . . . [etc.]"; or, 
"Scripture quotations marked (ESV) are from . . . [etc.]."  
The "ESV" and "English Standard Version" are trademarks of Good News Publishers. Use of either trademark 
requires the permission of Good News Publishers.  
 
When quotations from the ESV text are used in non-saleable media, such as church bulletins, orders of service, 
posters, transparencies, or similar media, a complete copyright notice is not required, but the initials (ESV) must 
appear at the end of the quotation.  
 
Publication of any commentary or other Bible reference work produced for commercial sale that uses the English 
Standard Version must include written permission for use of the ESV text.  
 
Permission requests that exceed the above guidelines must be directed to Good News Publishers, Attn: Bible 
Rights, 1300 Crescent Street, Wheaton, IL 60187, USA or permissions@gnpcb.org.  
 
Permission requests for use within the UK and EU that exceed the above guidelines must be directed to 
HarperCollins Religious, 77-85 Fulham Palace Road, HammerSmith, London W6 8JB, England.  
 
The Holy Bible, English Standard Version (ESV) is adapted from the Revised Standard Version of the Bible, 
copyright Division of Christian Education of the National Council of the Churches of Christ in the U.S.A. All rights 
reserved.  
 
Good News Publishers (including Crossway Bibles) is a not-for-profit organization that exists solely for the 
purpose of publishing the good news of the gospel and the truth of God's Word, the Bible. 

9.13 Good New Translation 
a. Copyright 

 
Good New Translation - Second Edition © 1992, American Bible Society. 
Used by permission. 
 

b. Permission to Quote GNT 
 
Bible text from the Good News Translation is not to be reproduced in copies or otherwise by any means except as 
permitted in writing by American Bible Society, 1865 Broadway, New York, NY 10023; www.americanbible.org.  



 

 
The GNT text may be quoted in any form (written, visual, electronic or audio) up to & inclusive of five hundred 
(500) verses without written permission, providing the verses quoted do not amount to 50% of a complete book 
of the Bible nor do the verses account for twenty-five percent (25%) or more of the total text of the work in 
which they are quoted. This permission is contingent upon an appropriate copyright acknowledgment. 
 

9.14 GOD’S WORD 
 
Copyright 1995 by God's Word to the Nations. 
Used by permission. All rights reserved. 
 

9.15 Greek New Testament, 4th revised edition 1993 
a. Copyright 

 
The Greek New Testament, Fourth Revised Edition edited by Barbara Aland, Kurt Aland, Johannes 
Karavidopoulos, Carlo M. Martini, and Bruce M. Metzger in cooperation with the Institute for New Testament 
Textual Research, Munster/Westphalia. © 1993 Deutsche Bibelgesellschaft, Stuttgart. Used by permission. 
 

9.16 Hebrew Names Version (HNV) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 

9.17 The Tanakh from JPS, 1917 (JPS1917) 
This work is in the Public Domain. 

9.18 King James Version (KJV) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.19 21st Century King James Version (KJ21) 
a. Copyright 

 
21st Century King James Version® copyright © 1994. 
Used by permission of Deuel Enterprises, Inc., Gary, SD 57237. All rights reserved.   
 

b. Permission to Quote KJ21 
 
The text of the 21st Century King James Version (KJ21), may be quoted in any form (written, visual, electronic, 
or audio) up to and inclusive of two hundred (200) verses without prior written permission of the publisher, 
provided that the verses quoted do not account for more than 40 percent of the work in which they are quoted.  
 
When the 21st Century King James Version, is quoted, the following credit line must appear on the copyright 
page or title page of the work:  

Scripture quotations taken from the 21st Century King James Version®, copyright © 1994. 
Used by permission of Deuel Enterprises, Inc., Gary, SD 57237. All rights reserved. 

Notwithstanding the above, short quotations from the KJ21 may be used without written permission for 
noncommercial purposes, such as church bulletins, orders of service, posters, transparencies, etc., with the 
designation KJ21® affixed at the end thereof, and for brief quotations in book reviews and articles.  



 

 
Quotations in excess of two hundred (200) verses or 40 percent of the work in which they are quoted, or other 
permission requests, must be directed to and approved in writing by Deuel Enterprises, Inc., PO Box 40, Gary, SD 
57237.  
 
Publication of any commentary or other Bible reference work produced for commercial sale that uses the 21st 
Century King James Version text requires written permission.  
 
Deuel Enterprises, Inc., PO Box 40 - 1111 Coteau Street, Gary, SD 57237, USA (877) 862-4253. 
 

9.20 La Biblia de las Américas (LBLA) 
a. Copyright 

La Biblia de las Américas 
Copyright 1986, 1995, 1997 

by The Lockman Foundation, La Habra, Calif. All rights reserved  
http://www.lockman.org (English) http://www.LBLA.org (Spanish) 

 
b. Permiso Para Citar 
 

El texto de La Biblia de las Américas(R) puede ser citado y/o reimpreso hasta quinientos (500) versículos sin 
necesidad de tener permiso escrito de The Lockman Foundation, siempre que los versículos no constituyan un 
libro completo de la Biblia o que formen más del 25% del total de la obra en la cual son citados.  

Una nota sobre los Derechos Reservados (Copyright) en la página en que se mencionan el título y los Derechos 
Reservados (Copyright) de la Obra que se publica, debe aparecer como sigue:  

 
"Las citas bíblicas son tomadas de LA BIBLIA DE LAS AMERICAS 
(C) Copyright 1986, 1995, 1997 by The Lockman Foundation 

Usadas con permiso. www.lbla.com"  

Cuando las citas de LBLA(R) son usadas en materiales sin propósito de venta, tales como boletines y programas 
de Iglesia, carteles de anuncio, transparencias o materiales similares, la abreviatura (LBLA) puede usarse al final 
de la cita.  
 
Una copia completa de la obra usando las citas de LBLA, si es publicada para venta debe ser mandada a The 
Lockman Foundation dentro de 30 días de su publicación.  
 
Las citas y/o reimpresión que pasen las limitaciones mencionadas, u otros permisos especiales, deben ser 
solicitados y aprobados por escrito por The Lockman Foundation.  
 
Este permiso para citar está limitado a los materiales que estén totalmente hechos de acuerdo con las provisiones 
de las leyes de Derechos Reservados (Copyright) de los Estados Unidos de América. The Lockman Foundation 
P.O. Box 2279, La Habra, CA 90632-2279, (714) 879-3055. http://www.lbla.com, http://www.lockman.org 
(English). 
 

9.21 Luther Bibel (LUTH) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.22 The Message (MSG) 
a. Copyright 

The Message by Eugene H. Peterson,  
Copyright (c) 1993, 1994, 1995, 1996,2000. 

Used by permission of NavPress Publishing Group. All rights reserved. 



 

b. Permission to Quote  
 
The Message text may be quoted in any form (written, visual, electronic, or audio), up to and inclusive of five 
hundred (500) verses, without express written permission of the publisher, providing the verses quoted do not 
amount to a complete book of the Bible nor do the verses quoted account for 25 percent or more of the total text 
of the work in which they are quoted. Notice of copyright must appear on the title or copyright page of the work 
as follows:  

The Message by Eugene H. Peterson, Copyright (c) 1993, 1994, 1995, 1996,2000. 
Used by permission of NavPress Publishing Group. All rights reserved.  

When quotations from The Message text are used in non-saleable media, such as church bulletins, orders of 
service, posters, transparencies, or similar media, a complete copyright notice is not required, but the title The 
Message must appear at the end of each quotation.  
 
Permission requests for commercial and non-commercial use that exceed the above guidelines must be directed 
to and approved in writing by NavPress, Rights and Permissions, P.O. Box 35001, Colorado Springs, CO 80935. 
 

9.23 Murdock New Testament (Murdock) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.24 New American Standard Bible Update 
a. Copyright 

 
New American Standard Bible Update  

Copyright © 1960, 1962, 1963, 1968, 1971, 1972, 
1973, 1975, 1977, 1995 by The Lockman Foundation  

All rights reserved.  
 
The 'NAS', 'NASB', 'New American Standard', and 'New American Standard Bible' trademarks are 
registered in the United States Patent and Trademark Office by The Lockman Foundation. 
 

a. Permission to Quote NASB® 
 
The text of the New American Standard Bible® may be quoted and/or reprinted up to and inclusive of five 
hundred (500) verses without express written permission of The Lockman Foundation, providing the verses do 
not amount to a complete book of the Bible nor do the verses quoted account for more than 25% of the total 
work in which they are quoted.  

Notice of copyright as shown below must appear on the title or copyright page of the work as follows:  
 

"Scripture quotations taken from the New American Standard Bible®, 
Copyright © 1960, 1962, 1963, 1968, 1971, 1972, 1973, 

1975, 1977, 1995 by The Lockman Foundation  
Used by permission."  

When quotations from the NASB® text are used in not-for-sale media, such as church bulletins, orders of service, 
posters, transparencies or similar media, the abbreviation (NASB) may be used after the quotation.  
 
This permission to quote is limited to material which is wholly manufactured in compliance with the provisions of 
the copyright laws of the United States of America and all applicable international conventions and treaties.  
 
Quotations and/or reprints in excess of the above limitations, or other permission requests, must be directed to 



 

and approved in writing by, The Lockman Foundation, PO BOX 2279, La Habra, CA 90631, (714)879-3055. 
http://www.Lockman.org. 
 

9.25 Nueva Biblia De Los Hispanos (NBLH) 
 

a. Copyright 
 
NUEVA BIBLIA DE LOS HISPANOS 
(c) Copyright 2005 by The Lockman Foundation 
La Habra, California 90631 
Sociedad no comercial 
Derechos Reservados 
http://www.NBLH.org (Español) http://www.lockman.org (English)  
 
Texto derivado de 
LA BIBLIA DE LAS AMERICAS(c) Copyright 1986, 1995, 1997 by The Lockman Foundation 
 
"NBLH" y "Nueva Biblia de los Hispanos" son marcas de The Lockman Foundation.  El uso de estas marcas 
registradas requiere el permiso de The Lockman Foundation.  
 
Quedan reservados en todos los países los derechos de reproducción y adaptación. 
 

b. PERMISO PARA CITAR 
 
El texto de la NUEVO BIBLIA DE LOS HISPANOS puede ser citado y/o reimpreso hasta quinientos (500) versículos 
sin necesidad de tener permiso escrito de The Lockman Foundation, siempre que los versículos no constituyan un 
libro completo de la Biblia o que formen más del 25% del total de la obra en la cual son citados. 
 
Una nota sobre los Derechos Reservados (Copyright) en la página en que se mencionan el título y los Derechos 
Reservados (Copyright) de la obra que se publica debe aparecer como sigue: 
  
"Las citas bíblicas son tomadas de la NUEVA BIBLIA DE LOS HISPANOS 
(C) Copyright 2005 by The Lockman Foundation. Usadas con permiso." 
 
Cuando las citas de NBLH son usadas en materiales sin propósito de venta, tales como boletines y programas de 
iglesia, carteles de anuncio, transparencias o materiales similares, la abreviatura (NBLH) puede usarse al final de 
la cita. 
 
Las citas y/o reimpresión que pasen las limitaciones mencionadas, u otros permisos especiales, deben ser 
solicitados y aprobados por escrito por The Lockman Foundation. 
 
Este permiso para citar está limitado a los materiales que están totalmente hechos de acuerdo con las provisiones 
de las leyes de Derechos Reservados (Copyright) de los Estados Unidos de América. The Lockman Foundation, 
P.O. Box 2279, La Habra, CA  90632-2279, (714) 879-3055. 
 

9.26 Holy Bible, New Living Translation (NLT) 
c. Copyright 

 
Holy Bible, New Living Translation copyright © 1996, 2004 by Tyndale Charitable Trust. Used by permission of 
Tyndale House Publishers Inc., Wheaton, Illinois 60189. All rights reserved.  
 
New Living, NLT, and the New Living Translation logo are registered trademarks of Tyndale House Publishers. 

9.27 New Revised Standard Version (NRSV) 
a. Copyright 



 

 
The Scripture quotations contained herein are from the New Revised Standard Version of the Bible, copyrighted, 
1989 by National Council of the Churches of Christ in the United States of America, and are used by permission. 
All rights reserved. 
 

9.28 THE ORTHODOX JEWISH BIBLE (OJB) 
a. Copyright 

 
The Orthodox Jewish Bible™ 
© Copyright 1999-2003. All rights reserved.  
AFI INTERNATIONAL PUBLISHERS  
 

b. Usage Information 
 
This data file is the sole property of AFI International. It may not be altered or edited in any way.  
All quotations must not exceed 60 words and must contain the copyright notice [i.e., "OJB Copyright © 1999-
2002 by AFI International"].  
Quotation may not be made without the permission of AFI International P. O. Box 2056 New York, NY 10163 
U.S.A.  
This material is solely for personal use and is not to be posted publicly on other web pages with the exception of 
brief quotations not exceeding 60 words.  
You are free to download, and print a copy of this material, so long as you do not post it on a different Internet 
site. You may, however, link this site to reference this Bible translation, THE ORTHODOX JEWISH BIBLE by 
linking to www.afii.org/ojbible.html.  
 

9.29 Palabra de Dios Para Todos (PDT) 
a. Copyright 
Palabra de Dios Para Todos 
Copyright © 2005 by World Bible Translation Center. 
All rights reserved. 

9.30 Restored Name King James Version (RNKJ) 
This Bible translation is in the Public Domain. 
 

9.31 Revised King James New Testament (RKJ) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.32 Revised Standard Version (RSV) 
a. Copyright 

 
The Scripture quotations contained herein are from the Revised Standard Version of the Bible, copyright © 1946, 
1952 and 1971 by the National Council of the Churches of Christ in the United States of America, and are used by 
permission. All rights reserved. 
 

9.33 Reina Valera Antigua (RVA) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 



 

9.34 1960 Reina Valera Revisada(RVR 1960) 
a. Copyright 

 
Scripture quotations marked (RVR 1960) are from the Reina Valera © 1960. El texto Biblico ha sido tomado de la 
version Reina-Valera © 1960 Sociedades Biblicas en America Latina ; © renovado 1988 Sociedades Biblicas 
Unidas. Utilizado con permiso.  
 

b. Permiso Para Citar 
 
The RVR 1960 text may be quoted in any form (written, visual, electronic or audio) up to and inclusive of five 
hundred (500) verses without written permission, providing the verses quoted do not amount to 50% of a 
complete book of the Bible nor do the verses account for twenty-five percent (25%) or more of the total text of 
the work in which they are quoted. This permission is contingent upon an appropriate copyright 
acknowledgement 
 
This permission is contingent upon an appropriate copyright acknowledgment. Any use of the RVR1960 shall be 
governed by above policy and shall be solely restricted to noncommercial, personal study purposes. 
 
For rights and permissions not expressly granted or referred to in this document, or for an explanation of any 
provision of this document write to: Copyrights & Permissions, American Bible Society, 1865 Broadway, New York 
10023.  

9.35 Revised Webster Bible (RWB) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.36 The Apostles’ Bible (TAB) 
This work is courtesy of Paul W. Esposito, and Stauros Ministries.  
 
 

9.37 Third Millennium Bible 
a. Copyright 

 
Third Millennium Bible® 

New Authorized Version, copyright © 1998. 
Used by permission of Deuel Enterprises, Inc., 

Gary, SD 57237. All rights reserved. 
 

b. Permission to Quote TMB 
 

The text of the Third Millennium Bible® (TMB®), New Authorized Version, may be quoted in any form (written, 
visual, electronic, or audio) up to and inclusive of two hundred (200) verses without prior written permission of 
the publisher, provided that the verses quoted do not account for more than 40 percent of the work in which they 
are quoted, and provided that a complete book of the Bible is not quoted.  
 
When the Third Millennium Bible, New Authorized Version, is quoted, the following credit line must appear on the 
copyright page or title page of the work: 

Scripture quotations taken from the Third Millennium Bible®, 
New Authorized Version, copyright © 1998. 
Used by permission of Deuel Enterprises, Inc., 

Gary, SD 57237. All rights reserved.  



 

Notwithstanding the above, short quotations from the TMB may be used without written permission for 
noncommercial purposes, such as church bulletins, orders of service, posters, transparencies, etc., with the 
designation TMB® affixed at the end thereof, and for brief quotations in book reviews and articles.  
 
Quotations in excess of two hundred (200) verses or 40 percent of the work in which they are quoted, or other 
permission requests, must be directed to and approved in writing by Deuel Enterprises, Inc., PO Box 40, Gary, SD 
57237.  
 
Publication of any commentary or other Bible reference work produced for commercial sale that uses the Third 
Millennium Bible, New Authorized Version text requires written permission.  
 
Deuel Enterprises, Inc., PO Box 40 - 1111 Coteau Street, Gary, SD 57237, USA (877) 862-4253. 

9.38 Weymouth New Testament (WEY) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.39 Webster Bible Translation (WST) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

9.40 World English Bible (WEB) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 

9.41 Young’s Literal Translation (YLT) 
This Bible translation is in the Public Domain. No one has rights to it. You may copy and post it as extensively as 
you wish. 
 

About Add-ons 

9.42 OakTree GNT Morphology 
Grammatical tagging by William D. Mounce and Rex A. Koivisto 
Copyright © 2004 William D. Mounce. 
Copyright © 2004 OakTree Software, Inc. 

9.43 Life Application Bible Notes  
LIFE  

APPLICATION®  
BIBLE  
 

Life Application is a registered trademark of Tyndale House Publishers, Inc. 

 


